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Chapter 1

About this release

This set of release notes contains important information not included in other Kofax Transformation Toolkit
documentation. Please read these release notes carefully before you install, upgrade, or use this product.

Information about supported operating systems and other requirements is available on the Kofax Support
website at www.kofax.com.

Version information
The Kofax Transformation Toolkit 6.4.0 release has the following build number, which appears in the
About Kofax window:

6.4.0.0.0.652

New features
The following new features are available in Kofax Transformation Toolkit 6.4.0.

Natural language processing improvements
The following features using the Natural Language Processing engine have been added.

Themes locator
A new locator is available that determines the theme of a document using the Natural Language
Processing engine. Using a table field, map columns for the theme, the confidence, and the sentiment of
the theme.

Summary locator
A new locator is available that extracts the summary of a document, page, or region, depending on the
locator settings. The results of this locator can be viewed so that the gist of the document is available
without reading the entire document.

OmniPage recognition engine
Kofax OmniPage is a new recognition engine that recognizes full pages or individual zones, depending
on the recognition profile. This engine supports a wide variety of languages and includes some business
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term dictionaries that may improve results. OmniPage, like other recognition engines, supports various
print types, such as hand writing, matrix fonts, etc. This new recognition engine is now installed alongside
Kofax Transformation Toolkit and should be used for all new recognition page and zone profiles.

The OmniPage recognition engine is a replacement for the RecoStar recognition engine that is now
deprecated.

For all new projects, the OmniPage recognition engine is used for the default page profile. In addition, the
default zone profile is an OmniPage profile that is specialized to recognized hand written alphanumeric
text. There are several other OmniPage zone profiles that are specialized for other zone configurations.

Paragraph detection
Paragraph detection is performed as part of recognition and takes advantage of character recognition.
Detected paragraphs can then be used as input for the Classification Locator or in a script.

For example, an organization processes large legal contracts and they want to check whether these
documents include an indemnity clause, an intellectual clause, or another clause. Rather than reading
the entire document it is possible to use paragraph detection and a Classification Locator to classify the
paragraphs to identify these clauses. This is possibly by populating a field with a single paragraph or by
populating a table with several paragraphs. This enables an operator to quickly access a clause or to find
documents where a clause was not detected.

Similarly, an organization receives a document that is issued by the government on a daily basis and
contains a list of newly registered companies. When a document is processed, it is necessary to place
each new company and its corresponding address into a database. The document is structured as a very
dense 6-column PDF where each company is a small paragraph. It is possible to use paragraph detection
and a script to populate the database.

Thin Client Server security updates
All third-party libraries used to build the Thin Client Server and its individual modules has been updated to
comply with current security standards. In addition to this, the user interface has been refreshed to match
corporate web-based standards.

Changes in behavior
The following changes have been made to the behavior of Kofax Transformation Toolkit 6.4.0.

Case sensitive ItemByName function
In scripting, the ItemByName function is now case sensitive.

For example, if you have a field called InvoiceNumber, referencing it in a script must use the following
case sensitive syntax:
pxDoc.Fields.ItemByName(“InvoicenNumber”).Text = “12345”

If you do not match the case of the field name, the script fails.
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License file .NET registration
In order to successfully use Kofax Transformation Toolkit, it is necessary to manually register some
licensing files to the Windows GAC using a .NET tool. For more information on this refer to the Kofax
Transformation Toolkit Developer's Guide.

Oracle drivers
If you are using an Oracle database and you are upgrading from a previous version to Kofax
Transformation Toolkit 6.4.0, it is necessary to re-install the Oracle drivers. The instructions for the Oracle
driver installation are in the Kofax Transformation Toolkit Installation Guide.

Reclassify documents in Validation script
You can change the classification results of a document in script by calling the Reclassify method in
validation script events.

The list of validation form events that now support the Reclassify method have been updated as
follows:
• Document_Validated *
• ValidationForm_DocumentLoaded *
• ValidationForm_AfterFieldConfirmed *
• ValidationForm_AfterTableCellConfirmed *
• ValidationForm_AfterTableRowAdded *
• ValidationForm_BeforeTableRowDeleted *
• ValidationForm_ButtonClicked *
• ValidationForm_AfterFieldChanged

• ValidationForm_AfterTableCellChanged

* Events supported by the Thin Clients.

RecoStar recognition engine deprecated
The RecoStar recognition engine is no longer installed by default with Kofax Transformation Toolkit.

When you open an existing project with Kofax Transformation Toolkit 6.4.0, any existing RecoStar
recognition profiles are disabled and a copy of a compatible OmniPage profile is created. For new
projects, Kofax recommends that you add OmniPage page and zone profiles.

Script pXDoc.Fields.ItemByName case sensitive
1445240: When using the pXDoc.Fields.ItemByName in script, this parameter is now case sensitive.
Any scripts that use this parameter must be updated accordingly.
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Thin Client encoding
No additional encoding or decoding is executed because HTTPS is now fully supported.

Thin Client session timeout
In order to change the session timeout from the default of 20 minutes, it is necessary to make two
changes to the web.config file.

SessionState
Edit the "timeout" attribute as necessary. This represents the number of minutes.
<sessionState mode="Custom" cookieName="ktsSessionId"
 regenerateExpiredSessionId="false" customProvider="KtsSessionStateStoreProvider"
 cookieless="false" timeout="20">

CustomBinding
The web socket cannot timeout before the session timeout. This means that this value must be at least 2
minutes longer than the session timeout.
Both the sendTimeout and the receiveTimeout attributes must be changed at the same time so that
they have the same values.
For example, if timeout="15", then the sendTimeout and receiveTimeout attributes must have a
value of 00:17:00. The format is HH:MM:SS for hour, minutes, and seconds.
<binding name="customMessageBinding" sendTimeout="00:22:00" receiveTimeout="00:22:00">
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Resolved issues

The following are the resolved issues in Kofax Transformation Toolkit 6.4.0.

Auto Folder issues
1456194: When used, the Auto Folder feature now initializes fields on new folders as expected.

Navigation after validation
1443847: After validating a document, Thin Client Validation now navigates to the next invalid document in
a batch, as expected.

Bar code value and checksum
1441234: By default, Code39 bar codes that contains asterisks should be recognized with the default
FineReader recognition settings. However, if FineReader fails to recognize a Code29 bar code using the
default settings, you can use scripting to improve the chances of bar code recognition. This is possible
because the IsCode39WithOutAsterisk behavior is now available for editing via script.

If you want to recognize code 39 bar codes with asterisks when checksum is enabled, you can add the
following code to the BeforeLocate event.
Private Sub Document_BeforeLocate(ByVal pXDoc As CASCADELib.CscXDocument, ByVal
 LocatorName As String)
 If(LocatorName = "BarcodeLocator") Then
  Dim Loc As CscBarcodeLocator
  Set Loc = Project.ClassByIndex(0).Locators.ItemByName(LocatorName).LocatorMethod
  Loc. IsCode39WithOutAsterisk = False
 End If
End Sub

PDF image loading issue
1404422: There are no longer issues when loading images in Thin Client Validation when the documents
are based on PDF import.
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Document_Validated event and reclassify
1399311, 1399099: If using Reclassify in AfterFieldConfirmed the Document_Validated event is
now successfully raised again when a field is confirmed.

TDS model failure
1399142: Trainable document separation now successfully classifies and separates documents without
issue.

Confirmed field with Enter key error
1397124: It is now possible to confirm a field by holding down the Enter key. When the next batch is
opened automatically, there is no error.

Field count data missing
1396686: Field Count data is no longer missing from the “Field Recognition Accuracy Per Day” report.

Confirm field error in Validation
1381523: It is now possible to use the Reclassify call in script without an error.

Table evaluation not working
1379761: Table evaluation is now performed successfully.

Validation error
1378131: An error no longer occurs in the Validation module.

Inheritance issues
1375723: When a child class has a different locator reread setting than its parent class, the parent reread
settings are no longer executed during extraction.
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Clipboard issues in Validation
1358297: It is now possible to copy and then paste using the Ctrl-based keyboard shortcuts or the
clipboard, as many times as necessary.

Reclassification via script error
1370292, 1352443: An error no longer occurs when a document is reclassified in script using the
AfterFieldConfirmed event.

HandleImagesBitonal blocks logins
1370066: Executing images in a bitonal format is now successfully performed on the Thin Client Server.

Datamatrix Bar code recognition issues
1369734: By default, Datamatrix bar codes should be recognized with the default FineReader recognition
settings. However, if FineReader fails to recognize a Datamatrix bar code using the default settings, you
can use scripting to improve the chances of bar code recognition.

This is possible because the DetectInvertedZones behavior is now available for editing via script.

If you want to recognize Datamatrix bar codes, you can add the following code to the BeforeLocate
event.
Private Sub Document_BeforeLocate(ByVal pXDoc As CASCADELib.CscXDocument, ByVal
 LocatorName As String)
 If(LocatorName = "BarcodeLocator") Then
  Dim Loc As CscBarcodeLocator
  Set Loc = Project.ClassByIndex(0).Locators.ItemByName(LocatorName).LocatorMethod
  Loc.DetectInvertedZones = False
 End If
End Sub

PDF error
1353640: Squares instead of the built-in PDF font are no longer displayed when rendering a PDF file.
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Last rubber banded value remembered
1346960: Repetitive changes to fields configured for autocomplete are now successfully saved to the
document.

Validation error
1346648: An error no longer occurs in the Validation module.

QR bar code recognition
1342366: By default, QR bar codes should be recognized with the default FineReader recognition
settings. However, if FineReader fails to recognize a QR bar code using the default settings, you
can use scripting to improve the chances of bar code recognition. This is possible because the
AdvancedExtractionMode behavior is now available for editing via script.

If you want to recognize QR bar codes, you can add the following code to the BeforeLocate event.
   Private Sub Document_BeforeLocate(ByVal pXDoc As CASCADELib.CscXDocument, ByVal
 LocatorName As String)
    If(LocatorName = "BarcodeLocator") Then
     Dim Loc As CscBarcodeLocator
     Set Loc = Project.ClassByIndex(0).Locators.ItemByName(LocatorName).LocatorMethod
     Loc.EnableAdvancedExtractionMode = False
    End If
   End Sub

Advanced Evaluator inheritance issue
1343422: Project Builder no longer crashes when a Script Locator is defined before an Advanced
Evaluator in the locator hierarchy of an inherited class.

Navigation error using folders and tables
1338595: When using a folder or a table in one of the Thin Clients, a loading message is no longer
displayed indefinitely when navigating to a previous document.

Script reclassify errors
1338529: It is now possible to reclassify a document via script without encountering an error.
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PDF routing errors in Validation
1330284, 1327445: A PDF can be successfully routed in Validation without causing an error.

Latency with scripts in Validation
1328691: In order to avoid this latency, a project Administrator needs to provide the database connection
type to ODBC window in script. A new property called ConnectionType is now available.

Here are the possible options for this new property.
• EnumConnectionType_Unknown

• numConnectionType_Odbc

• EnumConnectionType_OdbcSql

• EnumConnectionType_OdbcOracle

• EnumConnectionType_SqlServer

When you provide the specific ConnectionType, this bypasses any additional calls to the database that
check the database schema.

Sample script:
With odbDialog
   .ConnectionType = EnumConnectionType_OdbcSql
   mSupplier = .ShowDialog (CONNECTION_STRING,TABLE_NAME)
End With

Natural Language Processing confidence issue
1321559, 1320959: The confidence of an alternative is now the average confidence of all of the located
mentions.

Named Entity Locator highlight issues
1317047, 1317053: he best mention is now highlighted when viewing the Named Entity Locator results.

1317027, 1317030: When testing the Named Entity Locator, all locator alternatives are displayed in the
Document Viewer each time the Test button is pressed on the Test Results tab.

Named Entity Locator missing entities
1317021, 1317033: When extraction is performed for the Named Entity Locator, a complete list of entities
is now extracted as expected.
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Named Entity Locator missing scrollbar
1317020, 1317037: A scrollbar is now displayed when needed.

Training Extraction extra windows
1315675, 1246992: If there are no documents in a document set, the progress bar window is no longer
displayed if Extraction training is performed for that document set.

Entity extraction failure
1313696, 1320629: The Test button on the locator is now disabled if no language is configured at the
class-level.

Validation crash after Reclassify
1310150, 1305677: Validation no longer crashes when a user reclassifies via script and then closes the
module.

Table Locator end of table issue
1280195: The Table Locator now ignores lines extracted after the end of the table is found.

Representation overwrite issue
1266814, 1254229: The name of a representation is now updated correctly when OCR is performed on a
document that already has extraction results.

Error opening batch in Validation
1164456: An error no longer occurs because the Docking XML is now protected from corruption.
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Chapter 3

Known issues

The following sections describe known problems, and if available, useful workarounds for Kofax
Transformation Toolkit 6.4.0.

Broken forwards compatibility
If you open and save a project in Kofax Transformation Toolkit 6.4.0, that project can no longer be opened
in any previous version of Kofax Transformation Toolkit.

Merging projects with RecoStar profiles
1550791: When an older project that contains RecoStar profiles is upgraded to 6.4.0 and is then merged
to another 6.4.0 project, the recognition profiles of the merged project are corrupted.

Workaround: Follow these steps to merge two projects that have RecoStar recognition profiles from an
earlier version of Kofax Transformation Toolkit.

1. Open one of the older projects you are merging in Project Builder 6.4.0.
The RecoStar recognition profiles are converted to OmniPage profiles automatically.

2. If the default page or zone profile is set to a RecoStar recognition profile, modify the default profiles
to use either an OmniPage or FineReader profile.
Do not delete any of the RecoStar profiles.

3. Save and close the project.

4. Repeat Steps 1 to 3 for the other project that you are merging.

5. Use the Project Merge Tool to merge the projects.
The projects are merged successfully without any issues with RecoStar profiles.

Offline documentation
1593654, 1598378: The installation instructions in the Kofax Transformation Toolkit Developer's Guide to
install the offline documentation are not correct.

Workaround: Use the following steps to install the offline English documentation.
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Set up the offline documentation infrastructure:

1. Download and extract the KofaxTransformationToolkitDocumentation_EN.zip file that
contains the English documentation.

2. Create the offline help infrastructure.

a. On the server where Kofax Transformation Toolkit is installed, navigate to C:/intetpub/
wwwroot.

b. In the C:/intetpub/wwwroot folder, create a new folder and subfolder called KTT/en_US.

c. Copy the help folder from the extracted zip file into the newly created C:/intetpub/
wwwroot/KTT/en_US folder.

3. From the extracted KofaxTransformationToolkitDocumentation_EN.zip file, copy the
contents of the redirection folder to C:/inetpub/wwwroot.

Configure Kofax Transformation Toolkit to use offline help:

This is broken down into three components.
• The Runtime modules such as Validation or Server.
• The Design-time modules such as Project Builder or the Project Merge Tool.
• The Thin Client Server, if installed.

1. Configure the runtime modules to use offline help.

a. Navigate to %ProgramData%\Kofax\CaptureSV\Config\ and open the ACConfig.xml
file for editing.

b. After the <KfxDB></KfxDB> node, add the following content.
  <Transformation>  
     <Help Path="http://<servername>/KTT/" />
  </Transformation>

c. Save the file.

d. Open a runtime time module such as Correction and select Help > Contents from the menu or
press F1.
The help should open in English. If not, double-check the above steps and then try again.

2. Configure the design-time modules to use offline help.

a. Open Project Builder.

b. Click File > Options.
The Project Builder Options window is displayed.

c. Edit the Help Path to http://<servername>/KTT/.

d. Click OK.

e. Test your changes by clicking the Help button or pressing F1.
The help path should match the path entered in 2.c.
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3. Configure the Thin Client Server to use offline help.
Even if you have installed the offline documentation for the rest of the product, the configuration for
the Thin Client Server is different. Configure the Thin Client Server documentation as follows:

a. Navigate to where the Thin Client Server is installed.
By default, the path is <Program Files>/Kofax/Transformation/ThinClientServer.

b. Create a new folder called en_US.

c. From the extracted KofaxTransformationToolkitDocumentation_EN.zip file, copy
the help/TC folder to the newly created <Program Files>/Kofax/Transformation
Toolkit/ThinClientServer/en_US folder.

d. In <Program Files>/Kofax/Transformation Toolkit/ThinClientServer, open the
web.config file for editing as an Administrator.

e. Set the <setting name="HelpIsFileBased" serializeAs="String"> value to True.

f. In IIS, select your Thin Client Server application and then select the docs folder.

g. From the central panel, under the ISS group, double-click on HTTP Redirect.
By default, this points to https://docshield.kofax.com/KTT/6.4.0-uuxag78yhr$S$Q.

h. Edit the URL so that it points to your application, including the $S$Q suffix.
For example, http://<WebServer>/<Alias>$S$Q.
No matter what URL you use here, always use the $S$Q suffix at the end of the URL.

i. In the Actions panel to the right, click Apply.
The help application is set up.

j. Restart your server for the changes to take effect.

k. Open one of the Thin Client modules and test that the help works.
If there are any issues, repeat step 3 and try again.

KTM Statistics export connector not installed
If you selected the Statistics Release module when you installed Kofax Transformation Toolkit, the KTM
Statistics export connector is not successfully installed. Because of this it is not possible to apply this
export connector to a batch class and it is impossible to import and publish a batch class with statistics
release.

Workaround: Follow these steps to register the KTM Statistics export connector manually.

1. Open Kofax Capture Administration.

2. From the Tools tab, in the System group, click Export Connectors.
The Export Connector Manager window is displayed.

3. Click Add.
A Windows Explorer window opens.

4. Select KTMStatisticRelease.inf and then click Open.
The Add Export Conectors window is displayed.
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5. In the Add Export Connectors window, select KTM Statistics and then click Install.

6. When prompted, click OK to confirm that the registration of the KTM Statistics module is complete.

7. In the Add Export Connectors window, click Close.

8. In the Export Connector Manger window, click Close.

9. Close Kofax Capture.

You can now import and publish batch classes with the statistics export connector.

Root element error when documents copied via drag & drop
630605: When documents are copied via drag & drop, an error can occur when the project is trained or
when the documents are sorted on disk.

Workaround: When presented with this error, press the Ignore or the Ignore All button. Doing so repairs
the defective documents.

Table Locator text anchor issues
1323670: It is not possible to select an inherited Format Locator for use as a text anchor.

Workaround: Click the Copy Method button for the inherited locator and then configure it for use as the
text anchor.

Thin Client Server installation and Internet Information Services 8
1553170: When the Thin Client Server is installed using IIS 8, all user interface controls such as toolbars
and buttons are missing labels.

Workaround: Make the following changes in Internet Information Services (IIS).

1. Open IIS, navigate to and then select to your Thin Client Server web site.

2. In the central pane, double-click on MIME Types.
The MIME Types are displayed for the Thin Client Server web site.

3. Add a new MIME Type as follows.

a. Right-click anywhere in the MIME Types table and select Add.
The Add MIME Type window is displayed.

b. For the File name extension enter .json.

c. For the MIME type, enter application/json.

d. Click OK.

The new .json MIME type is added to the list.
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4. Restart the World Wide Web Publishing Service, and then try connecting to the Thin Client Server
again.

Thin Client Server timeout
1537221: The session timeout message is not displayed correctly and the session is not logged out
properly when the following criteria are met.
• In the web.config file, the websocket time and session timeout have the same value.
• In the web.config file, the difference between the websocket time and the session timeout are less than

two minutes.

Uninstalling Kofax Transformation Toolkit 6.4.0
619511: The removal of Kofax Transformation Toolkit 6.4.0 can fail because the Server Scheduler service
does not always stop in a timely manner when requested by the installer.

Workaround: Stop all Kofax Capture and Kofax Transformation Toolkit services before attempting an
uninstall.
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